	[image: image4.png]\

i =
4 2)
-:‘ 22
7
/
¢ /7,
o] e P
g v/;

ELSEVI ER




	Available online at www.sciencedirect.com
ScienceDirect
Procedia - Social and Behavioral Sciences 00 (2015) 000–000
	[image: image5.png]Procedia

Social and Behavioral Sciences





  www.elsevier.com/locate/procedia


8
 MACROBUTTON NoMacro Author name / Procedia - Social and Behavioral Sciences 00 (2015) 000–000

 MACROBUTTON NoMacro Author name / Procedia - Social and Behavioral Sciences 00 (2015) 000–000
9

World Conference on Technology, Innovation and Entrepreneurship 
 MACROBUTTON NoMacro Click here, type the title of your paper, Capitalize first letter

 MACROBUTTON NoMacro aFirst affiliation, Address, City and Postcode, Country
 MACROBUTTON NoMacro bSecond affiliation, Address, City and Postcode, Country 
Abstract

 MACROBUTTON NoMacro Click here and insert your abstract text.
© 2015 The Authors. Published by Elsevier Ltd.

Peer-review under responsibility of Istanbul Univeristy.
Keywords:  MACROBUTTON  AcceptAllChangesShown Type your keywords here, separated by semicolons ; 
1. Introduction

Here introduce the paper, and put a nome​nclature if necessary, in a box with the same font size as the rest of the paper. The paragraphs continue from here and are only separated by headings, subheadings, images and formulae. The section headings are arranged by numbers, bold and 10 pt. Here follows further instructions for authors.

2. Literature Review And Hypotheses 

· Structure

Files must be in MS Word only and should be formatted for direct printing, using the CRC MS Word provided. Figures and tables should be embedded and not supplied separately. 

Please make sure that you use as much as possible normal fonts in your documents. Special fonts, such as fonts used in the Far East (Japanese, Chinese, Korean, etc.) may cause problems during processing. To avoid unnecessary errors you are strongly advised to use the ‘spellchecker’ function of MS Word. Follow this order when typing manuscripts: Title, Authors, Affiliations, Abstract, Keywords, Main text (including figures and tables), Acknowledgements, References, Appendix. Collate acknowledgements in a separate section at the end of the article and do not include them on the title page, as a footnote to the title or otherwise.

Bulleted lists may be included and should look like this:

· First point

· Second point

· And so on

Ensure that you return to the ‘Els-body-text’ style, the style that you will mainly be using for large blocks of text, when you have completed your bulleted list. 

Please do not alter the formatting and style layouts which have been set up in this template document. As indicated in the template, papers should be prepared in single column format suitable for direct printing onto paper with trim size 192 x 262 mm. Do not number pages on the front, as page numbers will be added separately for the preprints and the Proceedings. Leave a line clear between paragraphs. All the required style templates are provided in the file “MS Word Template” with the appropriate name supplied, e.g. choose 1. Els1st-order-head for your first order heading text, els-abstract-text for the abstract text etc.
· Tables

All tables should be numbered with Arabic numerals. Every table should have a caption. Headings should be placed above tables, left justified. Only horizontal lines should be used within a table, to distinguish the column headings from the body of the table, and immediately above and below the table. Tables must be embedded into the text and not supplied separately. Below is an example which the authors may find useful.

     Table 1. An example of a table.

	An example of a column heading
	Column A (t)
	Column B (t)

	And an entry
	1
	2

	And another entry
	3
	4

	And another entry
	5
	6


· Construction of references

References must be listed at the end of the paper. Do not begin them on a new page unless this is absolutely necessary. Authors should ensure that every reference in the text appears in the list of references and vice versa. Indicate references by (Van der Geer, Hanraads, & Lupton, 2000) or (Strunk & White, 1979) in the text. 

Some examples of how your references should be listed are given at the end of this template in the ‘References’ section, which will allow you to assemble your reference list according to the correct format and font size.

· Section headings

Section headings should be left justified, bold, with the first letter capitalized and numbered consecutively, starting with the Introduction. Sub-section headings should be in capital and lower-case italic letters, numbered 1.1, 1.2, etc, and left justified, with second and subsequent lines indented. All headings should have a minimum of three text lines after them before a page or column break. Ensure the text area is not blank except for the last page.
· General guidelines for the preparation of your text

Avoid hyphenation at the end of a line. Symbols denoting vectors and matrices should be indicated in bold type. Scalar variable names should normally be expressed using italics. Weights and measures should be expressed in SI units. All non-standard abbreviations or symbols must be defined when first mentioned, or a glossary provided.
· File naming and delivery
Please title your files in this order ‘procedia acronym_conference acronym_authorslastname’. Submit both the source file and the PDF to the Guest Editor.

Artwork filenames should comply with the syntax “aabbbbbb.ccc”, where:

· a = artwork component type

· b = manuscript reference code

· c = standard file extension

Component types:

· gr = figure

· pl = plate

· sc = scheme

· fx = fixed graphic
· Footnotes

Footnotes should be avoided if possible. Necessary footnotes should be denoted in the text by consecutive superscript letters1. The footnotes should be typed single spaced, and in smaller type size (8 pt), at the foot of the page in which they are mentioned, and separated from the main text by a one line space extending at the foot of the column. The Els-footnote style is available in the MS Word for the text of the footnote.
Please do not change the margins of the template as this can result in the footnote falling outside printing range.
All figures should be numbered with Arabic numerals (1,2,3,….). Every figure should have a caption. All photographs, schemas, graphs and diagrams are to be referred to as figures. Line drawings should be good quality scans or true electronic output. Low-quality scans are not acceptable. Figures must be embedded into the text and not supplied separately. In MS word input the figures must be properly coded. Preferred format of figures are PNG, JPEG, GIF etc. Lettering and symbols should be clearly defined either in the caption or in a legend provided as part of the figure. Figures should be placed at the top or bottom of a page wherever possible, as close as possible to the first reference to them in the paper. Please ensure that all the figures are of 300 DPI resolutions as this will facilitate good output.

The figure number and caption should be typed below the illustration in 8 pt and left justified [Note: one-line captions of length less than column width (or full typesetting width or oblong) centered]. For more guidelines and information to help you submit high quality artwork please visit: http://www.elsevier.com/artworkinstructions Artwork has no text along the side of it in the main body of the text. However, if two images fit next to each other, these may be placed next to each other to save space. For example, see Fig. 1. 
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Fig. 1. (a) first picture; (b) second picture.

3. Methodology

3.1. Research Goal

In this survey we aim to identify the mediating effect of learning orientation on the relationship between leadership style and firm performance. To test the propositions, a field survey using questionnaires was conducted.

3.2. Sample and Data Collection

The survey of this study is conducted on 343 middle and senior managers of 125 high performing firms operating in manufacturing industry in Turkey, between the years of 2008-2010. Firms fulfilling the criteria that (1) being indicated in the list of “Fortune 1000 of Turkey” between the years of 1997-2007, and (2) not being undergone a loss for those 10 years, are indexed as high performing firms. 435 firms that meet those two requirements were contacted via email or phone and informed about the research. However 127 firms accepted to participate in and fill out the research questionnaire. Questionnaires obtained from two firms are eliminated because they did not meet the requirement that “respondents should be top managers or middle-level managers in their firms”. Data obtained from those 343 questionnaires were analyzed through the SPSS statistical packet program and three proposed relations were tested through regression analyses.  

3.3. Analyses and Results
To measure leadership style, 33 item-scale of Yukl (2002) is used. Learning orientation scale is adopted from Baker and Sinkula (1999), which uses 15 items to measure three dimensions (open-mindedness, shared vision, commitment to learning) of learning orientation. Firm performance scale is adopted from Khandawalla (1977) which uses 5 criteria to measure the overall performance. However, 14 items are deleted or because they showed a weak loading or loaded two different factor. Overall, 39 items using 5 likert-type scale are used to measure leadership style, learning orientation and firm performance. Those items with factor loadings can be seen on the Table 1. Also as it has been seen on the Table 2, the Cronbach’s Alpha values for each factors exceeds 0,70, which indicates the reliability of scales used in that survey. 
· Equations

Equations and formulae should be typed in Mathtype, and numbered consecutively with Arabic numerals in parentheses on the right hand side of the page (if referred to explicitly in the text). They should also be separated from the surrounding text by one space.
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4. Conclusion

This survey, which is conducted on high performing firms of Turkey survived in series of crises, highlighted the relationship among the leadership style, learning orientation and firm performance. The most striking result to emerge from data is that commitment to learning and shared vision and open-mindedness mediates the effects of task oriented leadership and relations oriented leadership behavior on firm performance. So, H2 (learning orientation mediates the relationship between task-oriented leadership and firm performance) and H3 (learning orientation mediates the relationship between relations-oriented leadership and firm performance) are fully supported. These findings are consistent with the literature on leadership and learning orientation.  Although there are so many studies examining the learning orientation-firm performance relation (Farrell et al., 2008; Mavondo et al., 2005; DeGeus, 1988; Sinkula et al., 1997; Dickson, 1992) and  leadership and learning orientation relation (Senge, 1990; Senge et al., 1994; Harbone and Johne, 2003; McDonough, 2000; Aragon-Correa et al., 2007) in literature; the mediator effect of learning orientation on the relationship between leadership behavior and firm performance is examined and revealed for the first time through that survey, which differentiates this survey from others. 

· Online license transfer

All authors are required to complete the Procedia exclusive license transfer agreement before the article can be published, which they can do online. This transfer agreement enables Elsevier to protect the copyrighted material for the authors, but does not relinquish the authors’ proprietary rights. The copyright transfer covers the exclusive rights to reproduce and distribute the article, including reprints, photographic reproductions, microfilm or any other reproductions of similar nature and translations. Authors are responsible for obtaining from the copyright holder, the permission to reproduce any figures for which copyright exists.

· Acknowledgements

Acknowledgements and Reference heading should be left justified, bold, with the first letter capitalized but have no numbers. Text below continues as normal.

· An example appendix

Authors including an appendix section should do so before References section. Multiple appendices should all have headings in the style used above. They will automatically be ordered A, B, C etc.
A.1.  Example of a sub-heading within an appendix

There is also the option to include a subheading within the Appendix if you wish.
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Instructions to Authors for Word template
1. Locking of Copyright:

The copyright line is locked in the Procedia templates. The author may not edit the same and making it editable only PSMs. If there are any copyright changes required, you are requested to contact Journal Manager through Guest Editors. For editable the below mentioned steps must be followed:

Steps:
· Click on copyright statement

· Click on Properties in Developer tab

· Remove the checks from Content control cannot be deleted and Contents cannot be edited under Locking and then Press ok
2. Docm format:

We have added macros in the Word templates for the below mentioned features. And since macros are not supported in doc and docx format we created the templates of all Procedia titles in .docm format.

· Removal of all highlights

· Accept track change

· Locking of Rules

If .docm format needs to convert in docx format then the following steps must be performed:

Steps:

· Press Alt  F11
· Click on Project (JID_Template)

· Enter "thomson" in Project Password

· Click on Microsoft Word Objects

· Click on ThisDocument under Microsoft Word Objects
· Delete all macros under General
· After deletion close the Code and Project (JID_Template) windows

· From File menu click on save as type .docx option


3. Comments added in the margin in Word master templates:

There are instances where author raising queries on what to do with key information lines such as “volume, page numbers”, “Conference title per issue” and “Copyright entity, year, copyright company Elsevier Ltd./B.V./Inc. and Organizer Name” in the copyright statement and for these concerns the comments have been inserted in the Word template to guide Author/JM about the information to be inserted by them in these fields. 

Comments removal from Print: In Word 2007 and 2010 the comments present in a document get printed by default. If the authors do not want to get the comments appearing in print, the authors must remove the comments from the Word template before printing by changing the Print markup setting of word using the following steps:
Steps:
· Click the File tab

· Click Print
· Under Settings, click the arrow next to Print All Pages
· Click Print Markup to clear the check mark 
Instructions to Authors pages to be excluded from Print: 

· Click the File tab

· Click Print
· Under Setting, Type page numbers and/or page ranges separated by commas counting from the start of the document or the section. For example, type 1, 3, 1-5 


4. PDF creation from Word master template:


While creating PDF from Word template the below given steps should be followed to avoid difference in trim size and margins and to avoid decrease in resolution and size of the figure images of the Word template and the PDF created.
Steps in Word 2007 and 2010:

· Click the File tab

· Click Print
· Under Printer tab, select Adobe PDF 
· Click Printer Properties link
· Under Adobe PDF Settings tab, click on Edit button
· Click on Images folder under Standard
· Make Downsample and Compression fields under Color Images and Grayscale Images "Off". And in Monochrome Images field make only Downsample "Off'
· Then click on OK and given name of the setting in File name tab and click on save
· Then again Under Adobe PDF Settings tab, click on Edit button
· Then click on Color folder 
· Choose Leave Color Unchanged option under Color Management Policies tab then click on OK
· Lastly click on OK in Adobe PDF Settings tab
· Click Save As
· Under Save as type, click the arrow next to PDF (*.pdf)

· Click Save

In Word 2003 the PDF can be created by using “Convert to Adobe PDF” symbol in tool bar or the required paper size can be adjusted in the Adobe PDF settings given in the Properties tab on the Print option. Please follow the above steps to avoid decrease in resolution and size of the figure images.


5. Reference styles used in Procedia master templates:

Title


Reference style 

AASPRO
 
2 Harvard 

AASRI Procedia
 
3 Vancouver Numbered 

APCBEE Procedia 
3 Vancouver Numbered 

EGYPRO
 
3 Vancouver Numbered 

FINE

   
2 Harvard 

IERI Procedia 

3 Vancouver Numbered 

MATPR


1a Numbered without article titles
MSPRO
 

2 Harvard 

PHPRO
 

2 Harvard 

PIUTAM
 
3a Embellished Vancouver 

Procedia CIRP 

3 Vancouver Numbered

PROCHE
 
3a Embellished Vancouver 

PROCS
 

3a Embellished Vancouver 

PROENG
 
1 Numbered 

PROENV
 
3a Embellished Vancouver 

PROEPS
 
3a Embellished Vancouver 

PROFOO   

3a Embellished Vancouver 

PROMFG

1a Numbered without article titles
PROTCY
 
3 Vancouver Numbered 

PROVAC
 
3a Embellished Vancouver 

SBSPRO
 
5 APA 

SEPRO
 

3a Embellished Vancouver 

AQPRO


2 Harvard

UMKPRO

5 APA
* Corresponding author. Tel.: � MACROBUTTON NoMacro +0-000-000-0000 �; fax: � MACROBUTTON NoMacro +0-000-000-0000 �.


E-mail address: � MACROBUTTON NoMacro author@institute.xxx �


1 Footnote text.
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